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SPECIFICATIONS 
 16MIPS RISC CPU for high-performance GPS system processing  

o Filtering for GPGGA/GPGSA to preserve RF Link bandwidth 

o Multi-threaded kernel performs real-time background processing 

 SDIO Micro-SD Memory Card support (J6) for  data logging onto FAT16/FAT32 media (up to T10 

(25Mhz HDLC) V2.0 32GB Cards) 

 High-performance uBlox LEA-5/6 GPS Receiver Module with uBlox u-Center USB support 

o Optional - Fastrax IT-500 for land-based operations (U4) 

 Flexible NMEA (WGS-84) output provides the widest range of interoperability with GPS software 

 Onboard Sarantel SL1206R GeoHelix®-P2 high-performance, high-gain, low-noise amplified active 

input GPS receiver antenna (J3) 

o Onboard SMA male external GPS antenna connector (J4) for optional dual GPS antenna 

 Two options for 30dbM (1W) 900Mhz FHSS Modem and 900Mhz Base station Modem, both options 

support channel interference detection and auto-mitigation 

o RFM DNT900C 30dbM (1W) 900Mhz FHSS Modem supporting 500Kbps datarate and up to 

16 independent channels (TDMA Dynamic mode) with AES Encryption for link security and 

requiring no Field configuration/provisioning (not available for Export outside the US).  

 Flexible base-station mode: RFM DNT900C 1W 900Mhz FHSS Base station module 

 Dual antenna: RPSMA Male AUX antenna (J11) or DNT900C onboard u.FL 

connector 

o External Antenna mounting with 90-degreee RPSMA (Female) to RPSMA (male) extension 

cable  

 Up to 12V, 10A input power support 

o Support for Triple Redundant/Fault-Tolerant System Power via Multiple Sources 

o VBAT1 – Primary Battery (J13) – Deans Male Connector 

o VBAT2 – Secondary Battery (J12) – Deans Male Connector 

o Back-up Battery – User supplied redundant Backup Battery (up to 29V)) – (TB1, BB+/-) 

 Solid-State Switchable Power Supplies for controlling all attached electronics on TB1 

o VBAT1 - Main system power via S4, JP9 (ALWAYS_ON) (external switch) 

o TB1-V1+/- Primary Flight Electronics CPU Power from VBATT 

o TB1-V2+/- Backup Flight Electronics Pyro Power from VBATT 

o TB1-U1+/- User Power from VBATT (Switched from Terminal Block) 

 Wireless controlled, electrically isolated Remote control Power  

o TB1-V1+/- Remote Control Primary Avionics/Flight-Computer Power On/Off (CH-1) 

o TV1-V2+/- Remote Control Backup Avionics/Flight-Computer Power On/Off (CH-2) 

o TB1-U1+/- User Power On/Off (CH-3) 

o Voltage/Current switching and monitoring, including full system power shut-down 

 Remote Control Deployment/Pyrotechnic Channels 

o SW controlled FET switch for ARM safety 

o TB1-P1+/- channel P1 

o TB1-P2+/- channel P2 

 MAX 11614 12-bit Analog to digital converter  

o Support for logging voltage measurements on all switchable power supplies 

o Support for logging two user defined Analog to Digital Converters (ADC) 

 TB1 A1+/- User ADC channel2 

 TB1 A2+/- User ADC channel 1 

 Temperature Sensing from -55°C to +125°C with 0.5°C Accuracy (Typ.) via TCN75. 



6 

REV C 08/25/12 

o GPMTW NMEA active output or console stats 

o Support for logging temperature with date and GPS location 

 Dual Digital Servo control channels 

o Digital servo PWM output range control for flight operations 

o JP1 – Servo Channel 1 

o JP2 – Servo Channel 2 

o JP3 – Servo Battery Power 

 Wireless configuration and monitoring of Power state via expert mode 

 Expert mode supports remote control wireless login shell with password protection featuring 

command line shell interface for advanced users 

 Pushbutton power with software de-bounce of 5-seconds and trick start-up to prevent unintended 

shutdown or operation 

 USB Serial port connection for Base-station as well as local display stats  

 Tested range: 45 miles  

 Supported software: any NMEA GPS Program (ExpertGPS, VisualGPS, Google Earth, etc) 

 Over 8hrs operational time (running all features) using 9.6V 2200mah NiMh 8xAA battery pack 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MECHANICAL 
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PCB DIMENSIONS 
 

 8050 x 1980 x 125 (LxWxH mils) 

 8.05” x 1.98” x 1/8” (LxWxH inches)  

 204.47x 50.29 x 3.75 (LxWxH mm)  

 
Assembled height: ½” High (fits inside 54mm Performance Rocketry AF Tube, slip fit in Coupler) 

 

Empty Weight: 4.2 oz (DNT900 Models), 4.8 oz (Digi Models) 

Flight Weight: 13.4 oz (DNT900 Models), 14 oz (Digi Models) 

Note: includes 9.6v 2200ma Battery, 0dBi RF Antenna, 6” RPSMA extension cable 

MODELS 
Designation: GPS Model – Modem Model – Antenna Stuff option 

 Mk1: UBX5-MAX-SL1206 

o uBlox LEA-5H GPS Receiver, Digi XT09 Modem (100mW/1W), SL1206 GPS Antenna 

 Mk2: UBX6-MAX-SL1206 

o uBlox LEA-5H GPS Receiver, Digi XT09 Modem (100mW/1W), SL1206 GPS Antenna 

 Mk3: UBX5-RFM-SL1206  

o uBlox LEA-5H GPS Receiver, RFM DNT900C 1W Modem, SL1206 GPS Antenna 

 Mk4: UBX6-RFM-SL1206 

o uBlox LEA-6H GPS Receiver, RFM DNT900C 1W Modem, SL1206 GPS Antenna 

 Base-station: BaseStation-1 

o Modem only, VFD, USB 2.0  

NOTE: all of the above may be ordered with external GPS antenna only (e.g. UBX6-RFM-None) 
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J8 System Boot-strap Configuration 
Board specific options for GPS enabled should be selected and verified first.  

 J8 Pin 7-8 Basestation : jumper J8 Pins 7-8 for Base-station mode (Base-station units only) 

 J8 Pin 9-10 Console: jumper 9-10 to immediately run GPS at boot (tracking mode only, no console) 

 

Note that some production systems may have these Bootstrap options hard-wired. 

J9 Microprocessor Serial Port to IO device Configuration 
 

Serial port configuration and operation of the jumper J9 is outlined below. For normal operations, jumper J9 as shown below (1-

3,2-4,7-9,8-10,13-15,14-16). 

 

Note that production systems may have these boot-strap configuration options hard-wired. 

J6 SD-Card Logging  
Any SDIO card may be used in J6, the SDIO slot. FAT12, FAT16 file systems are all supported. Long file names are NOT 

supported.  One 2GB SDIO card is provided with the system but any SDIO card will work. Be sure to format your SD-CARD for 

first use. Note that file system checking is performed at boot time. 
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S1-S4 System Buttons  

 

TB1 Terminal Block 

 

 
 
GPS Configuration 
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 U2 – uBlox LEA-5H/LEA-6H GPS Receiver 

 J3 – Sarantel SL1206R Onboard High Gain GPS Antenna 

 J4 - SMA Male GPS external antenna input 

 

 

Mounting/Installing GPS-TWO 
The GPS-TWO has 4 mounting holes labeled H1, H2, H3, H4. 4-40 screws and stand-offs as provided should be used in the 

mounting of the tracking module. The GPS-TWO operates best when bolted down to the vehicle with no grounding of the PCB, 

use felt washers for ensuring that there are no ground shorts to the vehicle. 

 

 

Use a ¼-20 drill bit for the RPSMA antenna socket. Drill the hole and put the nut on the top, screw in antenna. Optimally, the 

GPS shall be pointed up and the RPSMA pointed down or out of the way of the GPS antenna. External GPS antenna if needed. 
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THEORY OF OPERATION 
The GPS-TWO communicates with the host tracking & telemetry system via an RF-Modem which emulates an RS-232 serial 

device. The modem module is connected to a host computer via USB and host software is operated on that computer for GPS 

tracking. The Base Station parses NMEA sentences received by the remote, showing position, satellite information, and other 

remote telemetry. Additionally, the Basestation allows you to perform remote login to the GPS-TWO system, enable power or 

other critical system power, and then go into telemetry or “gps” mode. Once in telemetry mode, the remote will relay local GPS 

position to the base-station over the RF link. Base-station-1 models will include displays for viewing real-time vehicle telemetry 

at a glance without the use of a host computer. 

Powering on the GPS-TWO – Power Switching 
If Jumper J14 (Always On) is installed, when a battery is connected to VBAT1, the system will boot up and initialize, waiting for 

Login. If J8 pins 9-10 are jumpered on, the system will immediately go into Telemetry mode and start transmitting GPS 

sentences as well as Telemetry information. Optionally, the GPS-TWO can be turned on by pressing and holding S4 for 5 

seconds and then releasing if jumper J14 is NOT installed.  Note that the base-station should be booted prior to GPS-TWO being 

powered up so that clear air channel assessment and initialization of the RF modems on both sides is performed properly.  

 
GPS-TWO Batteries and Power 
GPS-TWO has been optimized for 9.6v operation and comes with an equipped battery and charger (9.6v 2200maH NiMh for 

remote and 2600 mah for the basestation). A Deans Male connector is installed on the main system boards and the provided 

battery should be connected to VBAT1.  For redundant power, a second battery may be mounted to VBAT2. For Triple 

redundant power, another DC power source (up to 29V) may be connected to TB1 (BB+/-).  

The GPS-TWO module will run on any 6V-29V DC power source but the typical operational time is expected to exceed 8 hours 

on a full charge with a single 9.6v 2200mAh NiMh battery pack connected to VBAT1. VBAT2 provides auxiliary power and BB+/1 

on TB1 provide additional, wired input without the use of the Deans connector. The power regulators are capable of handling 

input voltages up to 12VDC.  
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BaseStation ONE 
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The Base-Station One (B1) receiver connects to the GPS-2 remote telemetry board and provides for: 

 

 Realtime telemetry information: Position and other statistics 

 Remote Transmitter console access via USB for command/control and NMEA data from USB Port J15 

 Battery and Charger for up to 8hrs use 

 20x2 Vacuum Fluorescent Display (VFD) with MIL-SPEC Gray Filter 

 4 Mil-Spec Momentary Pushbutton with Black Pushbutton Sealing Boot 

 Red Mil-Spec sealed (IP68) SPST On/Off switch 

 NEMA-4X 9x3x2 FG Enclosure  

 NEMA 4X IP68 DC Power Charger and Plug 

 IP68 USB Cables (Cable Assemblies) USB MINI B 2M (6FT) CBL – MILSTD 

 Multi-Current Universal Smart Charger for 9.6V - 18V  

 

To use with console access, Connect the BaseStation module via supplied USB cable to your PC and to the USB connector 

labeled “J15”. Press the power switch and take note of the Serial port detected.  When the system boots, hit enter  a few times 

to go into local console mode. If the USB port is not connected, then the display stats will show on the local display. Firmware 

revisions in the future will support both local USB data and concurrent display logging. 

The GPS-TWO base-station (Basestation-1) features a USB Host interface to the onboard RF Modem, and may also have a local 

GPS for advanced tracking features. 

When you reboot BaseStation-1, with no USB keyboard input, it will go into non-interactive mode, local NMEA sentences 

received by the remote will simply be echoed to the console and no user command is available. 

 

BaseStation Buttons 
(Left to Right) 

1. Power 

a. Power/Current (Local/Remote), Battery Impedance and power usage (Local/Remote) 

2. System 

a. Uptime 

b. Local/Remote Temperature 

3. Modem/Satellites 

a. PRN Number (in Hexadecimal) and Relative Signal Strength Graph 

4. GPS Position 
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a. Position in DMS Format, Altitude, Lock status of remote GPS receiver 

 

 

PAIRING 

Systems come pre-paired with each other and are configured such that no two shall interfere with any other pair. Pairing 

additional devices to a given base-station is available on request and may later be configured by technical users with available 

software from Real Flight Systems. 

 
Antenna ConfiguratioN 
 

A 0dBi (low-gain) omni-directional antenna is supplied for the GPS-TWO transmitter, this truly omni-directional is better suited 

to a tumbling, rotating environment (e.g. apogee).   The RPSMA connector for the RF Modem is supplied via J11 for user-

supplied antenna options. 

The ground station package supports both a 3-4 dBi circularly polarized patch antenna (full hemisphere coverage) antenna and 

a 6-10 dBi vertical antenna for the horizon with 50-100% better coverage over the hemisphere from horizon to horizon.  

QuickStart Basestation Setup 
 

 Verify the GPS-2 Remote/Transmitter/Tracker has Jumper J8 pins 9-10 jumpered 

 Power on the base-station from 10 feet away 

 Press the GPS Position button (4
th

 button) 

 Wait until you see an airplane, altitude, and then look at Satellites (Button 3) 

o You need 4 satellites for lock, if you have 4 or more satellites, proceed to launch/flight. 

 

NOTE: Batteries will last approximately 8hrs on a full charge. When the Voltage for either main or 

remote reaches 5.36V or below, the system will no longer operate and should be shut down and 

recharged. 

EXPERT MODE SETUP 

Apple 
For Apple computers running OS/X, get a good GUI terminal emulator like ZOC from EmTec or if you know what you are doing, 

just install minicom. The FTDI driver is pretty universal and will show up on your system as a new serial device. If not, download 

the driver from FTDIchip.com or look on the CD. 

PC  
For Windows, use any terminal emulation program you have installed (e.g. Hyperterminal), or use Putty (located on the CD).  

Go to Device Manager and look under Com ports to find the name of the COM port to connect to.  Launch Putty, you will want 

to type the NAME of the Com-Port (e.g. COM23) into “serial line”, “9600” into speed, and type the name of the COM-Port (e.g. 

COM23) into the “Saved Sessions Field”. Press “Save”.  
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Next, click on the Serial item on the list to the left titled “Category” 
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Confirm flow control off and 8,1,N serial settings. Keep in mind that if you use a new USB port on Windows, you may have to go 

through this process again (a well endowed desktop system may support dozens of USB ports). When satisfied with the new 

connection profile click on “Session” (under Category) to return to the previous menu. Press “Save”, then press “Open”.  

Now, the next time you run Putty you may load the configuration and just press “Open”. 
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Reboot the Base-Station. When the Base-station boots hit enter to go into Basestation mode, you will see a message on the 

console asking for input, hit enter.  

 Boot the GPS receiver, if Jumper J8 J8 Pin 9-10 is removed, the system will boot and ask for your password.  

 

Type “rfs1” to login. To turn on/off power to any of the V1/V2/U1/P1/P2 terminal block leads, type the command “pwr on x” 

and “pwr off x” where x is any of the channels listed from the “pwr” command. 

  

When ready to start Telemetry tracking, type the command “gps” and GPS output will commence as is shown below. 

 
 

Now that your GPS is outputting standard NMEA sentences, you may use your favorite GPS tracking system of choice. Many are 

available, the example below uses TopoGraphic ExpertGPS which is included on your CD-ROM. Type “x” to exit GPS mode.  
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ExpertGPS System Tracking (Windows) 
 

 Launch Topografix ExpertGPS (Included on CD-ROM), you may also visit http://www.topografix.com/ for updated 

versions of ExpertGPS. 

 Edit->Preferences, select Serial port (note the unselected Serial port will differ on each system): 

 

 Tracking->Enable GPS Tracking 

Wait until the GPS-TWO device shows up in the Window and your altitude meter is operational (and clock) to be valid before 

proceeding with operations. The Blue LED glows solid with 3D Lock, check either with ExpertGPS or visually (for solid Blue LED) 

before commencing operations. 

ExpertGPS will show the GPS clock ticking when the GPS receiver is receiving from one satellite. When the altitude window is 

showing the altitude (slightly bouncing around), you will have 4-satellite lock and be able to report altitude in real-time – the 

vehicles is ready for flight. 

Boot GPS-TWO AND CONNECTING from a PC 
When you have your PC Terminal emulator console up, power up your GPS-TWO module (press and hold S4 for 5 seconds and 

release), you will see text messages for system initialization like below. When prompted for a password, you type rfs1 and press 

enter. You will be presented with the GPS-TWO command line interface (CLI). Note that if Jumper J8 pins 9-10 are jumpered, 

the system will immediately go into GPS telemetry mode. For more information, see “Command Reference”. 

 

U0 

  

  

  

 

******************* 

  

Real Flight Systems 

*******************  

 

Initializing I/O devices ...  

Modem: J8 JP1 Pin[1-2]: OFF - DNT900C 1Watt 

http://www.topografix.com/
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GPS:   J8 JP2 Pin[2-3]: ON - uBlox LEA-5H w/FLASH 

EXM:   J8 JP3 Pin[3-4]: OFF 

ch0:   J8 JP4 Pin[5-6]: 0 

ch1:   J8 JP5 Pin[7-8]: 0 

SUBA GPS2 Build #0 

sdio: SPI Mode, up to 32Mhz clock supported 

tb0: Phoenix SMKDS 1/16-3.5, #1751235, 10A/300V 

vbat: power on TB1: <V1,V2,U1,P1,P2> OK 

Real Flight Systems Avionics Firmware v1.03-BU (Jul 3 2011) 

PIC24FJ256GA106 

CPU clock (Fcy): 16000000 

FRCPLL4X: 32000000 

Modem: J8 JP1 Pin[1-2]: OFF - DNT900C 1Watt 

GPS:   J8 JP2 Pin[2-3]: ON - uBlox LEA-5H w/FLASH 

EXM:   J8 JP3 Pin[3-4]: OFF 

ch0:   J8 JP4 Pin[5-6]: 0 

ch1:   J8 JP5 Pin[7-8]: 0 

rf0: DNT900C - channel: 0 

gps0: uBlox LEA-5H 

SD:adding/opening SD/MMC (SPI) volume "sd:0:"... 

SD/MMC FOUND:  v2.0 standard-capacity SD card 

               Blk Size       : 1024 bytes 

               # Blks         : 1993728 

               Max Clk        : 25000000 Hz 

               Manufacturer ID: 0x1B 

               OEM/App ID     : 0x534D 

               Prod Name      : 00000 

               Prod Rev       : 65536.141568 

               Prod SN        : 0x0000B1D6 

               Date           : 9/8 

sd:0 opened successfully 

FAT32 Filesystem found 

               Sector  size: 512 B 

               Cluster size: 8 sec 

               Volume  size: 3987455 sec 

               497455 Clusters 

               170393 FATs 

               20415769600.00 Bytes available storage 

FAT filesystem volume mounted 

  

FS:init succeeded. 

Filesystem initialization completed 

Real Flight Systems - system init complete  

Console Stack: 512 bytes 

 

GPS2 login 

Password:**** 

GPS2 login success 

  

Welcome to GPS2! 

GPS2> 
 
You can then use the “hostname” and “pass” commands to change your system name and password. 
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Quick Start – GPS Tracking Only 
From the GPS2 command line interface type: 

GPS2> gps 

$GPGGA ….. 

Exit Terminal application, launch ExpertGPS 

Downloading SD-Card Data 
 

Copy the NME files off of the SD-Card, open them in your favorite GPS engine as NMEA 0813 data source. When using 

ExpertGPS, you have to rename the file with a “.nmea” extension to import. One you have imported the file, you may import 

the track and view the data.  

 
Downloading Telemetry Data 
 

Copy the PRN files off of the SD-Card and open them in Excel.  You can also rename the PRN file to a .csv file and open it in 

Excel.  

 

Restore Factory Defaults 
To restore factory settings (RF Channel, password, mode, etc), press and hold User (S3) and Pyro (S2) down for 10 seconds 

 

Certifications 
 Tripoli Rocketry Association (TRA)  approved for high-altitude GPS telemetry tracking and reporting 

 

 

WARNING: All liability waived. Rocketry is an inherently dangerous undertaking. Make your choices 

and take personal responsibility for the outcome of your endeavors, protect your privilege to fly rockets 

by not making the headlines or becoming a statistic. 

 

 

 

 

Appendix A: GPS-Two Command-Line QUICK Reference 
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 gps – enter telemetry mode 

 pwr – power on or off the terminal block 

 adc – read adc channels 

 hn – change hostname 

 save – save configuration 

 show – show configuration 

 pass – change / show password 

 restore – restore defaults 

 stat – show statistics 

 reboot – reboot system 

 

 

Examples 
 

GPS-2 login 

Password: rfs1  

Welcome to GPS-2! 

 

GPS-2>gps 

Opened file[sd:0:\gpstrack.nme] (rw) 

Entering Telemetry [NMEA 0183] output mode. 

        Type 'x' to exit and return to command shell 

 

$GPGSA,A,1,,,,,,,,,,,,,99.99,99.99,99.99*30 

$GPGGA,051732.00,,,,,0,00,99.99,,,,,,*64 
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$GPGGA,051732.20,,,,,0,00,99.99,,,,,,*66 

$GPGGA,051732.40,,,,,0,00,99.99,,,,,,*60 

$GPRMC,051732.60,V,,,,,,,041011,,,N*7C 

$GPGGA,051732.80,,,,,0,00,99.99,,,,,,*6C 

$GPGSA,A,1,,,,,,,,,,,,,99.99,99.99,99.99*30 

Closed Telemetry [NMEA 0183] logfile[sd:0:\gpstrack.nme] 

GPS-2> 

GPS-2>pwr 

        [0] Main: OFF 

        [1] CPU:  OFF 

        [2] CPU:  OFF 

        [3] User: OFF 

        [4] PYRO1:OFF 

        [5] PYRO2:OFF 

        ARMED status: OFF 

        Voltage status: offline 

GPS-2>? 

 

Real Flight Systems Avionics Firmware v1.04 (Oct  3 2011) - (SUBA) 

        Available commands 

        pwr [on|off] [0-5] - show power status, turn power on/off for 

a channel 

        pulse [ms] [0-5] - pulse a channel specified milliseconds 

on/off 

        rfc [ch] - get or optionally set RF channel [0-9] 

        gps - exit command shell and enter gps telemetry mode 

        tm [nmea|nmea+|aprs] - set/get telemetry options & mode 



24 

REV C 08/25/12 

        filter [gpgga|gpgsa|gpgsv] [count] - filter one in count 

        hn [name] - set/get station/host name 

        pass - set RF shell password 

        stat - show comm statistics 

        exit - logout and reauthenticate 

        show - show current settings 

        save - save current settings 

        restore - restore factory defaults 

        read - read EEPROM 

        servo [0|1|*] [dir+|dir-] [0-180] [ch0|ch1] - configure servo 

channels 

        ver - show firmware version 

GPS-2>show 

System Information 

        Host name: GPS-2 

        RF Data rate: 0 (BR0) 

        RF Power level[0-4]: 4 [1W] 

        RF Channel ID: 0 

        Password: rfs1 

        Last MSL: 0 M (0'), Highest MSL: 0 M (0') 

GPS-2>pass 

checking 20 bytes of configuration data 

Saved configuration, data checksum: d0c9 

GPS-2> 

GPS-2>pass rfs1 

checking 20 bytes of configuration data 

password: rfs1 



25 

REV C 08/25/12 

GPS-2> 

GPS-2>restore 

checking 20 bytes of configuration data 

RESTORE DEFAULTS: checksum d0c9 

Restored defaults, data checksum: d0c9 

checking 20 bytes of configuration data 

GPS-2> 

GPS-2>stat 

        UART Stats 

          RF Modem (UART1): 0 in, 0 out; rx 0 cps, tx 0 cps fe 0 oe 0 

          GPS Telem(UART2): 0 in, 66 out; rx 0 cps, tx 0 cps fe 0 oe 0 

        GPS Stats 

                GPGGA:4 

                GPGLL:0 

                GPGSA:0 

                GPGSV:1 

                GPRMC:2 

                GPVTG:0 

                Fix Status (FS): 0, HDOP: 0, Comsats: 0 

                Fix Status (FS): Invalid Fix 

                Last MSL: 0 M (0'), Highest MSL: 0 M (0') 

                Temperature: 76.0F, 24.5C 

GPS-2> 

GPS-2>pulse 

GPS-2> 

GPS-2>pulse 0 100 
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GPS-2> 

GPS-2>pulse 0 100 

pulsed channel: 0 for 0ms (1->0) 

GPS-2> 

GPS-2>pulse 1 100 

pulsed channel: 1 for 1ms (1->0) 

GPS-2> 

 

 

 

 

 
 

Appendix-A: DNT900 Modem Configuration 

 
The DNT900 RF Modem onboard the GPS-TWO is pre-configured and paired for your base-station.  

Tampering with the system and reconfiguring the modem is not supported. 

 

Appendix B: U-Blox Default Configuration (UBX-CFG) 
 

The U-Blox module comes pre-configured for operation, should you lose your settings due to some 

inadvertent reconfiguration, the below settings should be used for all rocket flights. For all experimental 

rocket flights up to and exceeding Mach, the Airborne Dynamic platform model must be used. Failure to 

do so will yield inaccurate results or render the Base-station useless except when connected to the Base 

station console port via USB.   Connect the USB port on the remote board to the USB cable and then 

connect the USB Host port on your PC (where you run uCenter). uCenter is provided on the CDROM, you 

may also get the latest version of uCenter from uBlox – http://www.ublox.com/ 

Once you start uCenter, select “Receiver” menu option and then select “Port” and find the USB port 

which is connected to the host PC, use this one to connect directly to the uBlox GPS receiver.  

http://www.ublox.com/
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Note: Under Windows, to find the USB port name/number connected on your system, disconnect all 

USB peripheral devices, go to “Control Panel”, go to “Device Manager” and then click on the Icon “Ports 

(COM & LPT)” – you should see a uBlox receiver device listed, the designated COMXX (where XX is your 

Port #). This should be the COM port you select from uBlox uCenter. 

Once your GPS receiver is connected under uCenter, you should see a blinking connector which shows 

your COM port and 9600 next to it.  

You can now select the configuration of the GPS with View->Configuration View or Ctrl+F9. 

Each of the settings will be provided below for reference, you may use these to confirm proper 

configuration of your GPS receiver.  

 

 

When you move through the screens below, you will be asked to save the configuration. Click yes to 

update the configuration parameters of the GPS receiver.  

ANT 
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CFG 

 

DAT 
 

 

 

 

 

 

 

NAV 
NAV should be set to 7 – Airborne < 4g 
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NAV2 
NAV2 should be also set to 7 – Airborne < 4g 

 

NAV5 
Set Dynamic Model 8 – Airborne < 4g, and set Fix Mode to 3 – Auto 2D/3D, this will ensure you always 

get position even if altitude is not seen. The highest altitude seen can always be retrieved from the 

console with the “stat” command. 

 

RATE 
RATE can be set up to 3Hz (default). Select 333ms for 3Hz rate, 1000ms for 1HZ. Note that higher rates 

do not yield higher performance (in fact, higher rates may cause serial data corruption and loss). 
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CFG 
VERY IMPORTANT: when done with the above configuration settings, go back to the CFG screen, select 

“Save current configuration”, highlight all Devices and verify the “Devices” is check. Then press “Send” 

or navigate away from the page. You may power-cycle your system to confirm the settings took affect. 

 

Note that other screen and menu options may be available, where not shown above, the defaults are 

used. Note also that NAV5 mode is configured by default and that the NAV, NAV2 modes may only be 

valid for older versions of uBlox firmware. 

 

 

 



31 

REV C 08/25/12 

Pre-FLIGHT 
 

Charge all batteries, they should be about 11V or more when fully charged. The systems will shut down 

when the battery voltage reaches 5.36v, this is nominally 8hrs later.  

Install CR2032 Batter for GPS Almanac back-up 

Load the GPS Almanac – use uCenter (on the CDROM) and select “14 Day Almanac Plus” 

Verify Lock sequence where you have multiple (> 4 total) satellites, a flashing airplane, and altitude. 

Freshly format SD Card 

Check Connections to TB1 

 

POST-FLIGHT 

 
NOTE: VERY IMPORTANT, after the system is shut-down after the flight, FIRST REMOVE THE SD-CARD.  

If the SD-CARD is not removed, the NMEA and sensor data for your flight will be lost when the system 

starts up again and over-writes the flight data file! 

Charge Batteries 

 

 

 

 

 

 

 

 

 

Opening NMEA Data Files with Google Earth 
1) Rename the NMEA log file gpstrack.nme to gpstrack.nmea 
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2) Launch Google Earth, the version used is as shown (6.2.2.6613) 

Check Version 

 

File->Open 

 

 

 

Select “All Files” 
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Double click on the NMEA data file (gpstrack.nmea). A Dialog is presented to show options for the NMEA 

data-file import. 

Select Import Options 

 

The above dialog is display, Select “Create KML Tracks”, deselect other options.The file is opened and 

the Globe will move to the tracks just imported. 

Move to Location 
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Double clock on the GPS Device, then click on the Tracks, and then the Arrow symbol entitled “No 

Name”. Google Earth will Zoom in on the area of interest, you can move the Google earth nobs to get a 

better view of the data. 

 

 

 

 

 

 

 

 

 

 

Reposition View 



35 

REV C 08/25/12 

 

 

Save GPS Track as KMZ File 
Right click on the GPS Device and select “Save Place as” 
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Elevation Profile 
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To show the Elevation Profile, right click on the tracks as below: 

 

 

Importing Sensor Data into Microsoft Excel 
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1) Launch Microsoft Excel, File->Open, All Files Selected 

 

Import Wizard Page one 

 

Select Delimited File, Press Next 
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Wizard Page Two: Select Delimiters 

 

Select Tab, Comma, Space,  and option “Treat consecutive delimiters as one”, “Text pattern” is “*”, press Finish” 

Data Imported 

 

Insert Row for Labels, press “ALT+i+r” to insert a row with the cell cursor centered at 1A, the labels are as below: 

Tag,Seconds,Main Batt,GPS Batt,Main Current,User Current,V1 Volts,V2 Volts,U1 Volts,U2 Volts,Temp (F),Temp ( 

C),LRC 
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Plot main Battery Voltage 

 

 

Select all Main Batt cells, press Insert->Chart,etc. 



41 

REV C 08/25/12 

Plot Main Battery Current 

 

 

Select the Main current column, select Insert, Chart->3DLine and notice the plot.  
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Plot Temperature 

 

Select the Temperature (F) row (all cells). Select the Insert 3D Line chart option. 
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Total Time running 

 

 

Select the last row of seconds data, divide by 60 for minutes, divide that result by 60 for hours. 
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Notes 
The same techniques for other row data from V1/V2,U1/U2 may be used to view additional peripherals. 

 

 


